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MODULUL 1: Concepte de bază ale tehnologiei informaţiei 

Calculatorul, ca parte inegrată a unui sistem informatic (i.e., în sens larg, sistem care 
permite introducerea de date, stocarea, prelucrarea şi transmiterea acestora), este caracterizat 
(din punct de vedere structural) prin componentele sale hard (hardware, i.e., totalitatea 
componentelor sau echipamentelor fizice din configuraţie, utilizate în sistemul informaţional 
pentru culegerea, validarea, stocarea, prelucrarea şi transmiterea datelor) şi soft (software, i.e., 
componenta logică a sistemului informatic – programe, proceduri, rutine etc.; conduce şi 
controlează activitatea tuturor componentelor hardware în rezolvarea problemelor concrete). 

1.1.  Arhitectura unui sistem de calcul 

Din punct de vedere funcţional, arhitectura sistemului de calcul (i.e., PC – calculator) 
este compusă din: 

 unitatea centrală, i.e., placa de bază (eng.,motherboard), reprezintă 'componenta cheie'
a unui sistem de calcul şi, în acelaşi timp, o 'puntede legătură' (i.e., prin intermediul căreia 
toate celelalte sub-sisteme 'comunică'), fiind constituită din: 

o procesor (i.e., CPU; eng., Central Processing Unit);
o chipset (pereche de circuite integrate specializate, i.e., northbridge şi southbridge,
care fac legătura între CPU şi dispozitivele de viteză ridicată, e.g., memoria RAM şi 
controlerul grafic, respectiv perifericele de viteză scăzută); 
o unitatea de memorie internă (RAM, ROM – BIOS);
o interfeţe/porturi (integrate în southbridge, e.g., IDE, SATA, USB, respectiv într-
un circuit integrat specializat, i.e., Super I/O,e.g., seriale, paralele, PS/2 etc.); 
o senzori (e.g., temperatură, tensiune, turaţie etc.).

 dispozitive periferice de intrare (e.g., tastatură, mouse, microfon, scaner etc.) şi de
ieşire (e.g., monitor, imprimantă, boxe, proiector video etc.); 

 dispozitive de stocare (e.g., HDD, CD/DVD, floppy disk, memorii flash etc.);

 sursă de alimentare;

 programe de sistem, i.e., sistemul de operare (e.g., Windows, Linux, MacOS etc.);

 programe de aplicaţii, fiecare având o funcţie specifică, e.g., manipulare şi gestiune a
fişierelor (Windows Explorer), procesare text sau calcul tabelar (Word, Excel etc.), gestiune a 
bazelor de date (Access, Oracle etc.), comunicare (Yahoo! Messenger, Skype, Opera, Outlook 
Express etc.), compilatoare şi interpretoare pentru limbaje de programare (Visual C++), 
divertisment (Winamp, Windows Media Player etc.), utilitare (WinRAR) etc. 
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1.1.1. Indicatori de performanţă 

Pentru unitatea centrală, în general, indicatorii de performanţă privesc: 

 unitatea de memorie internă:
o capacitatea unităţii de memorie internă, i.e., cantitatea de date care poate fi stocată
(se măsoară în MB, e.g., 2048/4096/8192 MB); 
o frecvenţa de lucru a memoriei (se măsoară în MHz, e.g., 400/800/1333 MHz);
o latenţa, i.e.,intervalul de timp determinat de momentul generării semnalului de
acces la memorie şi momentul disponibilităţii datelor (e.g., CL6, CL9 etc.). 

 procesorul:
o numărul de nuclee şi tehnologia de fabricaţie (e.g., 4 nuclee / 22 nm);
o tipul şi numărul de memorii cache (e.g., L1 32 KB x 4, L2 256KB x 2 etc.);
o frecvenţa (viteza de lucru), i.e., numărul de cicluri maşină pe care poate să îl facă
procesorul în fiecare secundă (se măsoară în GHz, e.g., 3 GHz); 
o dimensiunea cuvântului (se măsoară în biţi, e.g., 8/16/32/64 biţi).

 numărul de sloturi pentru memorie, i.e., posibilitatea de a extinde capacitatea unităţii
de memorie internă, respectiv numărul şi tipul de periferice şi porturi integrate (e.g., controler 
video, codec audio, controler Ethernet, cameră web, microfon, HDMI/USB 2.2/USB 3.0, 
VGA etc.), disponibilitate tehnologii wireless (IrDA, Bluetooth etc.). 

Pentru dispozitivele periferice, în general, indicatorii de performanţă privesc: 

monitorul:
o tehnologia de fabricaţie (e.g., cu tub catodic, TFT, LCD, OLED etc.);
o rezoluţia (măsurată în pixeli, e.g., 800x600/1600x900 etc.), diagonala (măsurată
în inch, e.g., 15.6''), intensitate luminoasă (e.g., 200 cd/m2), reproducere culori (e.g., 
24/32 biţi), rata de refresh (e.g., 60/75 Hz)  etc.; 

 imprimanta (multifuncţională):
o dimensiuni mediu prinatare (e.g., A5/A4, coperţi CD-uri, etichete, plicuri etc.);
o tehnologie (e.g., inkjet, i.e., cu tuş, respectiv laser);
o tip (e.g., alb-negru sau color);
o funcţii disponibile (e.g., imprimare, copiere, scanare, fax etc.);
o viteza de printare (e.g., 8.7 ipm alb negru / 5 ipm color);
o nivel de zgomot, putere consumată etc.

Pentru dispozitivele de stocare, în general, indicatorii de performanţă privesc: 

HDD – ul:
o capacitate (măsurată în GB sau TB, e.g., 300 GB / 1 TB);
o viteza de rotaţie (măsurată în rpm, e.g., 5400/7200 rpm);
o interfaţa şi rata de transfer (e.g., SATA 3, 600 MB/s) etc.
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1.1.2.  Fişă de lucru 
 

1. Folosind următoarea succesiune de operaţii (pentru navigarea în Meniul Start), i.e., 
Start (Ctrl+Esc) → Control Panel → System and Security → System, să se noteze: 

a) numărul de niveluri ale memoriei cache: ..................................................................; 
b) frecvenţa de lucru a procesorului: ............................................................................; 
c) capacitatea memoriei instalate: .................................................................................; 
d) sloturile pe care este instalată unitatea de memorie: ................................................; 
e) versiunea de BIOS: ...................................................................................................; 
f) tehnologia de fabricaţie a procesorului: ..................................................................... 
 

2. Folosind aplicaţia CPU – Z, să se noteze: 
a) numărul de niveluri ale memoriei cache: ..................................................................; 
b) frecvenţa de lucru a procesorului: ............................................................................; 
c) capacitatea memoriei instalate: .................................................................................; 
d) sloturile pe care este instalată unitatea de memorie .................................................; 
e) versiunea de BIOS: ...................................................................................................; 
f) tehnologia de fabricaţie a procesorului: ..................................................................... 
 

3. Aţi întâmpinat dificultăţi în demersul dumneavoastră ? Dacă da, menţionaţi-le în 
continuare: .................................................................................................................................... 
....................................................................................................................................................... 
 

4. Cunoaşteţi o altă metodă prin care pot fi dobândite informaţii utile despre sistemul 
informatic ? Dacă da, menţionaţi metoda cunoscută: .................................................................. 
....................................................................................................................................................... 
 
1.1.3.  Evaluare 
 

1. Windows Explorer este un program de aplicaţie şi are următoarea funcţie specifică: 
 a) de divertisment; 

b) de procesare text; 
c) de manipulare şi gestiune a fişierelor; 
d) de gestiune a bazelor de date. 

2. Memoria cache L1: 
 a) are, în general, capacităţi de ordinul GB sau TB; 

b) este integrată la nivelul CPU; 
c) este un dispozitiv de stocare extern; 
d) are, în general,o viteză de lucru de ordinul kHz-ilor. 

3. O adâncime de culoare de 24 de biţi presupune că: 
 a) monitorul poate reproduce aproximativ 16.7 milioane de culori; 

b) monitorul poate reproduce aproximativ 4.3 miliarde de culori; 
c) monitorul poate reproduce aproximativ 24 de culori; 
d) monitorul este alb-negru. 

4. Un cuvânt (în accepţiunea sistemelor informatice) poate reprezenta: 
 a) o instrucţiune; 

b) un set de date; 
c) o instrucţiune şi un set de date; 
d) o instrucţiune sau un set de date. 
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(Pagină destinată notării întrebărilor şi răspunsurilor formulate în timpul cursului) 
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1.2.  Sistemul de operare 
 

Primul pas este întotdeuna ... pornirea calculatorului. Pornirea sistemului informatic se 
realizează prin apăsarea butonului Pornit/Oprit (eng., Power), aflat de cele mai multe ori pe 
partea din faţă a carcasei sau, mai nou, pe monitor. 
 

Pentru oprirea/repornirea calculatorului dispunem de două opţiuni : 
1. succesiunea de operaţii Start → Turn Off Computer → Turn Off/Restart; 
2. combinaţia de taste Ctrl+Alt+Delete (apăsate simultan), urmată de succesiunea de 
operaţii (efectuate cu mouse – ul, i.e., click) Shut Down → Turn Off/Restart. 

 
După instalarea unui nou sistem de operare, utilizatorii pot configura, preferenţial, 

anumiţi parametri funcţionali ai sistemului informatic de lucru, cum ar fi: 
1. data şi ora (dublu click asupra indicaţiei de oră); 
2. limbă (click pe indicatorul de limbă sau succesiunea de operaţii Start → Date, 
Time, Language and Regional Options → Regional and Language Options); 
3. inhibarea lansării implicite (i.e., după boot) a unei aplicaţii (Ctrl+Esc → click 
opţiunea Run → tastare cuvânt cheie 'msconfig' → click OK → selecţie opţiune 
Startup → navigare → selecţie aplicaţie → click Apply → click Close → click 
Restart / apăsare tasta R); 
4. instalarea de noi aplicaţii (i.e., software specializat, jocuri etc.); 
5. personalizarea spaţiului de lucru şi (sau) a interfeţei utilizator; 
6. instalarea de noi periferice (i.e., imprimantă, camera web etc.);  
7. crearea şi restricţionarea conturilor de utilizator, partiţionarea HDD-ului etc. 

 
După configurarea sistemului informatic, în general, utilizatorul îşi stabileşte propriul 

sistem de organizare a informaţiilor pe suport extern (HDD), i.e., structura ierarhică de dosare 
(creare, modificare atribute etc.) şi fişiere (identificare nume, atribute şi extensii, modificarea 
atributelor şi a denumirii, salvare pe dispozitive externe, arhivare, localizare cu (fără) criterii 
specifice etc.). 
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1.2.1.  Fişă de lucru 

1. Folosind programul de aplicaţie Windows Explorer:
a) determinaţi capacitatea partiţiei de sistem şi spaţiul disponibil (liber) ....................;
b) determinaţi dimensiunea dosarului „Program Files” ...............................................;
c) determinaţi numărul de dosare şi fişiere incluse în ierarhia dosarului „Program
Files” (aflat pe partiţia de sistem) .................................................................................. 

2. Creaţivă propria ierarhie de documente şi fişiere (minim niveluri de ierarhizare a
dosarelor şi minim 5 fişiere, de diferite tipuri şi cu diferite conţinuturi, create într-unul din 
dosarele de la nivelurile inferioare ale ierarhiei. Apoi: 

a) la finalizarea ierarhiei, folosind utilitarul WinRAR, arhivaţi (separat) fiecare fişier
creat, consemnând observaţiie dumneavoastră: ............................................................. 
.........................................................................................................................................
......................................................................................................................................... 
b) copiaţi ierarhia de documente şi fişiere pe un dispozitiv extern;
c) printaţi un fişier din ierarhia de documente şi fişiere creată.

1.2.2.  Evaluare 

1. Termenul de boot defineşte:
a) procedura de iniţializare a unui sistem informatic;
b) procedura de modificare a atributelor unui fişier;
c) procedura de ierarhizare a unui arbore de dosare şi fişiere;
d) procedura de instalare a unui sistem de operare.

2. Succesiunea combinaţiilor de taste Ctrl+C şi Ctrl+V defineşte operaţia de:
a) decupare;
b) ştergere;
c) printare;
d) copiere.

3. WinRAR este un utilitar folosit pentru:
a) copierea documentelor pe dispozitive externe (CD/DVD);
b) arhivarea documentelor;
c) protecţia antivirus a documentelor;
d) modificarea atributelor unui document.

4. Modificarea alfabetului utilizat se realizează cu ajutorul următoarei combinaţii:
a) Ctrl+Alt+Del;
b) Alt → Shift;
c) Shift+Del → click YES;
d) click F2 → Apply.
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MODULUL 2: Editoare de text şi de calcul tabelar 

2.1.  Editoare de text – Microsoft Office Word 

Folosind cunoştinţele dobândite în urma lecturării Anexei nr. 1 (i.e., Microsoft Office 
Word) se cere: 

1. Să se reproducă primele patru pagini ale acestui document;
2. Să se realizeze un CV personalizat (http://www.europass.cedefop.europa.eu).

2.2.  Calcul tabelar – Microsoft Office Excel 

Folosind cunoştinţele dobândite în urma lecturării Anexei nr. 2 (i.e., Microsoft Office 
Excel) se cere: 

1. Să se realizeze planificarea unui proiect (la alegere) şi diagrama Gantt asociată;
2. Să se realizeze un istoric anual al temperaturilor din Bucureşti şi să se evidenţieze

codurile galbene şi cele roşii de caniculă (text, culoare şi simbol). Istoricul ar trebui să permită 
şi extragerea valorilor asociate unei singure zile. 

2.3.  Aplicaţii vizuale şi grafice – Microsoft Office PowerPoint 

Folosind cunoştinţele dobândite în urma lecturării Anexei nr. 3 (i.e., Microsoft Office 
PowerPoint) se cere: 

1. Să se realizeze o prezentare cu titlul „Arhitectura unui sistem de calcul”.
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MODULUL 3: Baze de date 

3.1. Îmbinarea corespondenţei 

Unul din cele mai bune exemple de utilizare, în viaţa de zi cu zi, a unei baze de date este 
procedura de îmbinare a corespondenţei. 

Îmbinarea corespondenţei presupune următoarea succesiune de operaţii: 

 se alege tipul de corespondenţă dorit
o Mailings → Start Mail Merge → Letters;

 se conectează documentul original la baza de date
o Mailings → Select Recipients → Type New List (dacă baza de date nu există);
o Mailings → Select Recipients → Use Existing List (dacă baza de date există);

 automat, se activează celelalte butoane din lista Mailings
o Insert Merge Field (i.e., inserează un câmp la poziţia cursorului);
o Preview Results (i.e., comută din modul vizualizare al câmpului la conţinut);
o Edit Recipient List (i.e., editarea şi filtrarea datelor);
o Finish & Merge (i.e., fuzionarea datelor din baza de date cu documentul standard).

3.2. Fişă de lucru 

Redactaţi o scrisoare către părinţii clasei de elevi prin intermediul căreia să le aduceţi la 
cunoştinţă situaţia şcolară anuală a elevului. Sugestie: baza de date folosită la fuzionare va fi 
un document EXCEL. 

3.3. Evaluare 

1. Când este activat butonul Edit Recipient List:
a) după ce s-a ales Insert Merge Field;
b) după ce s-a ales Start Mail Merge;
c) după ce s-a ales Select Recipients.

2. Dacă baza de date pentru fuzionare nu există se alege opţiunea:
a) Use Existing List;
b) Type New List;
c) Select from OutLook Contacts.

3. Ce rol are butonul Preview Results:
a) inserează un câmp la poziţia cursorului;
b) editarea şi filtrarea datelor;
c) comută din modul vizualizare al câmpului la conţinut.

4. Pentru a adăuga un câmp într-o tabelă (New Adress List) se foloseşte butonul:
a) OK;
b) New Entry;
c) Customize Columns.
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MODULUL 4: Informare şi comunicare 

WWW apare ca o colecţie de informaţii structurate sub formă de documente Web sau 
pagini Web. Mai multe pagini Web, organizate ierarhic, formează un site. Site-ul reprezintă 
un ansamblu de pagini Web, între care sunt definite legături, astfel încât, pornind de la o 
primă pagină a cărei adresă reprezintă adresa site-lui, este posibilă navigarea prin toate 
paginile acestuia. Site-urile sunt găzduite pe servere speciale numite servere Web. Navigarea 
pe Web se face cu ajutorul unor programe numite browsere Web. 

4.1.  Motoare de căutare 

Căutarea pe Web este o sarcină dificilă şi o mare parte din efortul de dezvoltare a unui 
motor de cătare este alocată procesului de ierarhizare, respectiv alocării unui scor pentru 
fiecare pagină indexată în funcţie de relevanţa estimată cu privire la interesul utilizatorului. 
Acesta este un aspect critic, în special din perspectiva influenţei semnificative asupra modului 
în care utilizatorii percep sau evaluează eficienţa unui motor de căutare. „Utilizatorul este 
tentat să urmeze, de regulă, doar primele câteva rezultate returnate de motorul de căutare, 
ceea ce face ca precizia algoritmului de alocare a unui scor adecvat să joace un rol deosebit 
de important”1. 

Pentru o perioadă destul de lungă, principalele motoare de căutare au rămas relativ 
aceleaşi pentru majoritatea utilizatorilor, având în frunte Google. În SUA se vehiculează 
noţiunea de „The Big 5” pentru a desemna cele mai bine plasate cinci motoare de căutare, 
respectiv Google, Bing, Yahoo, Ask.com şi AOL. Împreună, acestea primesc sute de miliarde 
de interogări în fiecare lună. Între timp, multe alte iniţiative au contribuit la evoluţia şi 
consolidarea tehnologiilor specifice dar, din păcate, au rămas doar note de subsol în istoria 
motoarelor de căutare. 

Motorul de căutare Google îşi are originea într-un proiect studenţesc al lui Sergey Brin 
şi Larry Page, studenţi ai Universităţii Stanford. Bineînţeles, de la momentul proiectării în 
anul 1998 Google a crescut enorm, în prezent ajungând motorul de căutare dominant. Google 
a devenit practic sinonim cu „a căuta”, fiind des utilizat în discuţiile de zi cu zi ca principala 
soluţie la aproape orice întrebare fără răspuns imediat: Nu ştii răspunsul? Caută-l pe Google! 
Dezvoltarea continuă a Google de-a lungul anilor este datorată unui număr foarte mare de 
factori, a căror simplă explicare ar putea face obiectul unei întregi lucrări de cercetare. Pe 
scurt însă, Google reușește să ofere răspunsul pe care utilizatorii îl caută, într-o maniera 
plăcută şi confortabilă, făcându-i astfel pe aceştia mulţumiţi de rezultatul obţinut şi implicit 
eliminând dorinţa de a încerca o soluţie alternativă. Determinantă în acest sens este 
perseverenţa Google de a îşi ajusta algoritmul de căutare de cel puţin câteva ori pe lună pentru 
a asigura o îmbunătăţire continuă a experienţei vizitatorilor. 

1 Menczer, F. G. Pant, and P. Srinivasan, Crawling the web, 2004. 
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4.2.  Construirea unui site (limbajul HTML) 
 

HTML (eng., Hyper Text Markup Language) reprezintă un set de coduri logice care 
constituie apariţia unui document web şi a informaţiilor pe care acesta le deţine. 

Structura elementară HTML este denumită tag, acesta fiind descris prin următoarele 
elemente componente: început (i.e., marcat prin apariţia simbolului '<'), element sau etichetă 
HTML (i.e., primul cuvânt care apare după simbolul de început al tag-ului), atribut (i.e., apare 
imediat după element şi descrie proprietăţile elementului), valoarea atributului (i.e., scris între 
ghilimele; între atribut şi valoarea sa se pune semnul '=') şi sfârşit (i.e., distins prin simbolul '/' 
dinaintea încheierii '>'). Observaţie ! Primul tag deschis este ultimul tag închis. 

Un document HTML este alcătuit din mai multe elemente şi atributele lor, după cum 
urmează: elementul principal (i.e., <html> … </html>, cuprinde toate datele documentului) şi 
elementele sub-principale (i.e., <head> … </head> respectiv <body> … </body>, primul va 
cuprinde titlul paginii web în timp ce al II-lea va cuprinde conţinutul documentului ce va fi 
afişat în pagina de web). 
 

Proprietăţile documentului HTML (e.g., culoarea fondului de pagină, textului sau a unui 
link) pot fi controlate prin intermediul atributelor elementului <body>. Astfel, culorile sunt 
setate pornind de la cele de bază (i.e., R, G, B) şi sunt reprezentate sub formă hexazecimală, 
scrisă între ghilimele şi precedată de simbolul '#'. Atributele BGCOLOR şi TEXT folosesc la 
modificarea culorii de fundal respective a culorii textului principal (i.e., corpul documentului).  
 
<html> 
 <head> 
  <title>TEST</title> 

</head> 
 
<body bgcolor="#7373A1" text="#000000"> 
 Hello World! 
</body> 

</html> 
 

Asemenea editoarelor de text, limbajul HTML permite formatarea textului folosind 
următoarele tag-uri: 

 <Hx> ... </Hx> 
o indicat la editarea titlurilor (x fiind un numar între 1 şi 6); 
o mărimea textului variază de la foarte mare <H1> până la foarte mic <H6>. 

 <p> ... </p> 
o lungimea de afişare a textului este ajustată de mărimea deschiderii browser-ului şi 
fiecare paragraf începe la un nou rând; 
o distanţa dintre două paragrafe succesive este mai mare, deoarece browser-ul le 
afişează cu un rând gol între ele. 

 <b> ... </b>, <i> ... </i>, <u> ... </u> 
o modifică aspectul textului: îngroşat, înclinat, subliniat. 
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<strike>…</strike>, <sup>…</sup>, <sub>…</sub>
o text tăiat, în poziţie superscript (i.e., exponent) , în poziţie subscript (i.e., indice).

Paginaţia poate fi ajustată cu ajutorul: 
 folosind atributul align al tag-ului <p>

o iniţializat cu unul din argumentele justify, left sau right.
 folosind codul numeric special &#09;

o înlocuieşte tab-ul şi realizează aliniere textului, la început de paragraf.
 folosind tag-ul <span> … </span>

o cu atributul style, la rândul său iniţializat cu argumentul padding-left:40px.

<html> 
 <head> 

<title>TEST</title> 
</head> 

<body bgcolor="#7373A1" text="#000000"> 
2&#158;H<sub>2</sub>O == OH<sup> ‐ </sup> + H<sub>3</sub>O<sup> +</sup> 

</body> 
</html> 

Pentru diacritice se vor folosi codurile numerice ale caracterelor speciale, e.g., &#351; 
pentru ş, &#355; pentru ţ şi &#259; pentru ă. 

Pentru marcatori şi numerotare se vor folosi: 
<ul> … </ul>

o tag folosit în formarea listelor neordonate;
o tipul marcajului se modifică prin intermediul atributului type, e.g., disc, circle;
o elementele listei se introduc cu ajutorul tag-ului <li> … </li>.

<ol> … </ol>
o tag folosit în formarea listelor ordonate;
o tipul marcajului se modifică prin intermediul atributului, e.g., „1”, „a”, „i”;
o vorbind de o listă ordonată se poate dori, la un moment dat, resetarea valorii
iniţiale a numerotării sau pornirea ei de la o anumită valoare; pentru aceasta se va 
folosi atributul start precedat de valoarea la care se doreşte pornirea numerotării 
elementelor din listă. 
o elementele listei se introduc cu ajutorul tag-ului <li> … </li>.

... 
<body bgcolor="#7373A1" text="#000000"> 

<p> 
Aceasta este o list&#259; ordonat&#259; a numerelor 0xA3 &#351;i 0b100001: 
<ul type=”circle”> 
<li> 0b100001= 1&#158;2<sup>5</sup> + 1&#158;2<sup>0</sup> = 33; </li>  
<li> 0xA3 = A&#215;16<sup>1</sup> + 3&#215;16<sup>0</sup> = 164; </li> 
</ul> 
</p> 

</body> 
...
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4.3.  Publicarea unui site 
 

Pentru publicarea unui unui site al cărui domeniu este de forma <nume>.ro acesta (i.e., 
domeniul) se poate achiziţiona la www.rotld.ro. După achiziţionarea domeniului este construit 
site-ul (Observaţie ! Dacă site-ul colectează informaţii pe bază de formulare, acesta trebuie să 
fie înregistrat la www.dataprotection.ro). Apoi, se achiziţionează, instalează şi configurează 
un server web care va găzdui site-ul. În cele din urmă se atribuie DNS-ul corespunzător la 
www.rotld.ro (vezi secţiunea Administrare Domenii), asociere care durează aproximativ 48 de 
ore. 
 
4.4.  Comunicarea folosind servicii on-line 
 

Printre cele mai cunoscute servicii de comunicare on-line este cel de poştă electronică 
sau e-mail-ul (i.e., schimbul de mesaje text, în general, completate de imagini şi alte tipuri de 
documente ataşate la mesajul text iniţial e.g., yahoo, google etc.). 

La acesta se adaogă serviciile care permit schimbul de mesaje instant şi conferinţele 
video (e.g., Yahoo ! Messenger, Skype, Lync etc.) sau serviciile de socializare (e.g., Twitter, 
Facebook etc.). 

Pentru această secţiune aplicaţia de lucru constă în crearea, personalizarea (ierarhie de 
dosare, editarea unei semnături etc.) şi utilizarea unui cont de poştă electronică. 
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(Pagină destinată notării întrebărilor şi răspunsurilor formulate în timpul cursului) 
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CHESTIONAR PENTRU EXAMINARE FINALĂ 

(NR. 1) 
 

1. Mouse-ul este un dispozitiv: 
 a) periferic de intrare; 

b) periferic de ieşire; 
c) periferic de intrare-ieşire. 

2. Windows-ul este un: 
 a) antivirus; 

b) sistem de operare; 
c) limbaj de programare. 

3. Orice formulă (în EXCEL) începe cu simbolul: 
 a) + (plus); 

b) = (egal); 
c)  : (două puncte). 

4. Media aritmetică (în EXCEL) este realizată de funcţia: 
 a) IF; 

b) SUM; 
c) AVERAGE. 

5. Pentru arhivarea documentelor se poate folosi utilitarul: 
 a) Windows Explorer; 

b) Notepad; 
c) WinRAR. 

6. Introducerea unui caracter ca exponent se face prin aplicarea efectului: 
 a) subscript; 

b) shadow; 
c) superscript. 

7. Referirea unei celule în mod absolut faţă de rând şi faţă de coloană se face ca în exemplul: 
 a) A$5$; 

b) $A$5; 
c) $A$1$5. 

8. Memoria cache L1: 
 a) are, în general, capacităţi de ordinul GB sau TB; 

b) este integrată la nivelul CPU; 
c) este un dispozitiv de stocare extern. 

9. Modificarea alfabetului utilizat se realizează cu ajutorul următoarei combinaţii: 
 a) Ctrl+Alt+Del; 

b) Alt → Shift; 
c) Shift+Del → click YES. 

10. Introducerea caracterelor speciale se face din meniul Insert prin opţiunea: 
 a) Autotext; 

b) Break; 
c) Symbol. 
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CHESTIONAR PENTRU EXAMINARE FINALĂ 
(NR. 2) 

1. Succesiunea combinaţiilor de taste Ctrl+C şi Ctrl+V defineşte operaţia de:
a) ştergere;
b) copiere;
c) decupare.

2. Windows Explorer este un program de aplicaţie şi are următoarea funcţie specifică:
a) de procesare text;
b) de manipulare şi gestiune a fişierelor;
c) de manipulare şi gestiune a bazelor de date.

3. Prin shortcut se înţelege:
a) un folder;
b) o cale rapidă de a ajunge la un fişier; 
c) o aplicaţie care permite crearea de documente. 

4. Un fişier creat cu PowerPoint are extensia mplicită:
a) .doc;
b) .txt;
c) .ppt.

5. Un motor de căutare este:
a) un program de navigare pe Internet;
b) un program de trimitere a mesajelor;
c) un site specializat pentru căutarea informaţiilor pe www.

6. Oprirea calculatorului se face cu ajutorul succesiunii de operaţii:
a) Start → Turn Off Computer → Turn Off;
b) Start → Turn Off Computer → Restart;
c) Start → Turn Off Computer → Stand By.

7. Pentru realizarea sumei primelor cinci rânduri de pe coloana A se foloseşte relaţia:
a) A1+A2+A3+A4+A5;
b) = SUM(A1:A5);
c) SUM(A1, A2, A3, A4, A5).

8. Memoria RAM este:
a) volatilă;
b) permanentă;
c) de ordinul KB.

9. Un paragraf este:
 a) o pagină de text; 

b) o frază; 
c) un bloc de text care începe şi se termină prin apăsarea tastei ENTER.

10. Introducerea caracterului special $ (dolar) se poate introduce în text:
a) de la tastatură;
b) din meniul Insert, prin opţiunea Simbol;
c) ambele variante anterioare.
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CHESTIONAR PENTRU EXAMINARE FINALĂ 

(NR. 3) 
 

1. Termenul de boot defineşte: 
 a) procedura de instalare a unui sistem de operare; 

b) procedura de modificare a atributelor unui fişier; 
c) procedura de iniţializare a unui sistem informatic. 

2. USB 2.0 este: 
 a) un dispozitiv periferic de intrare-ieşire; 

b) un port/o interfaţă; 
c) un program de sistem. 

3. La executarea unui click-dreapta cu mouse-ul: 
 a) apare o fereastră; 

b) apare un meniu; 
c) apare un icon. 

4. Termenul de WEB defineşte: 
 a) un site; 

b) un PC conectat la Internet; 
c) serviciul www. 

5. Numerotarea paginilor unui document WORD se face cu: 
 a) Insert → Page Numbers; 

b) Insert → Symbol; 
c) File → Page Setup. 

6. Repornirea calculatorului se face cu ajutorul succesiunii de operaţii: 
 a) Start → Turn Off Computer → Turn Off; 

b) Start → Turn Off Computer → Restart; 
c) Start → Turn Off Computer → Stand By. 

7. Pentru realizarea mediei aritmetice a primelor 3 rânduri de pe coloana A folosim relaţia: 
 a) A1+A2+A3; 

b) = SUM(A1:A3) / 3; 
c) = SUM(A1, A2, A3, A4, A5) / 5. 

8. Succesiunea de taste Alt → Shift permite: 
 a) schimbarea alfabetului utilizat; 

b) schimbarea sistemului de operare; 
c) schimbarea fontului. 

9. Pentru vizitarea site-urilor se foloseşte: 
 a) Windows Explorer; 

b) OutLook Express; 
c) Internet Explorer. 

10. Introducerea caracterului special $ (dolar) se poate introduce în text: 
 a) de la tastatură; 

b) din meniul Insert, prin opţiunea Simbol; 
c) ambele variante anterioare. 
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CHESTIONAR PENTRU EXAMINARE FINALĂ 
(NR. 4) 

1. Proiectorul video este un dispozitiv:
a) periferic de intrare;
b) periferic de ieşire;
c) periferic de intrare-ieşire.

2. Dacă baza de date folosită în fuzionare nu există atunci se foloseşte opţiunea:
a) Type New List;
b) Use Existing List;
c) Select from OutLook Contacts.

3. Memoria ROM este:
a) volatilă;
b) permanentă;
c) de ordinul TB.

4. Modificarea alfabetului utilizat se realizează cu ajutorul următoarei combinaţii:
a) Ctrl+Alt+Del;
b) Alt → Shift;
c) Shift+Del → click YES.

5. Orice formulă (în EXCEL) începe cu simbolul:
a) + (plus);
b) = (egal);
c) : (două puncte).

6. Oprirea calculatorului se face cu ajutorul succesiunii de operaţii:
a) Start → Turn Off Computer → Turn Off;
b) Start → Turn Off Computer → Restart;
c) Start → Turn Off Computer → Stand By.

7. O adâncime de culoare de 24 de biţi presupune că:
a) monitorul poate reproduce aproximativ 16.7 milioane de culori;
b) monitorul poate reproduce aproximativ 4.3 miliarde de culori;
c) monitorul poate reproduce aproximativ 24 de culori.

8. WinRAR este un utilitar folosit pentru:
a) editarea fişierelor;
b) ştergerea fişierelor;
c) arhivarea fiţierelor.

9. Introducerea unui caracter ca indice se face prin aplicarea efectului:
a) subscript;
b) shadow;
c) superscript.

10. Introducerea caracterului special $ (dolar) se poate introduce în text:
a) de la tastatură;
b) din meniul Insert, prin opţiunea Simbol;
c) ambele variante anterioare.
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